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Adobe Illustrator: A Complete Course and 

Compendium of Features is your guide to building 

vector graphics, whether you’re creating logos, icons, 

drawings, typography, or other illustrations—and 

regardless of their destination: print, web, video, or 

mobile. First, with a complete course that includes 

a set of projects and lessons created by Adobe 

Certifi ed Instructor Jason Hoppe, you will learn the 

procedures needed to use Illustrator e� ectively and 

professionally. Dozens of lessons are included that 

can be applied to any graphics you have in mind. 

Through these step-by-step lessons, you’ll learn all of 

Illustrator’s features in practical contexts and its best 

practices for optimal workfl ows.

To complete the course, the lesson documents 

and their assets are available to download. These can 

even serve as starting points for your own projects.

Then, for greater depth of knowledge and 

subsequent reference, you’ll use the compendium to 

uncover more of the “how” and  “why” of Illustrator.

Each topic is easy to access, and you can fi nd and 

explore all of Illustrator’s key features and concepts 

in depth. With cross references between the 

course and compendium, the two parts of the book 

complement each other perfectly. Best of all, when 

the lessons in the course are done, the compendium 

will continue to serve for months and years to come.

Learn step-by-step how to:

• Draw basic shapes and lines

• Build graphics using Illustrator’s deep and 
diverse toolset

• Create complex icons using the Pathfi nder and 
Shape Builder

• Use color with predictable and harmonic results

• Work e� ectively with type

And much more!
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Preferences

Document-Specific and Global
For Illustrator to run as smoothly as possible within your workflow, you will need to set up 
your preferences to your liking. Preferences on a Mac are under the Illustrator menu >  Pref-
erences. On a PC they are under the Edit Menu > Preferences.

VERY Important Note: I strongly recommend that you change the preferences with no doc-
ument open because this will set the preferences for the application. Any preferences set with 
a document open will only be applied to that document.

At times, preferences may become damaged and may need to be reset to their default 
values. To restore preferences, press and hold Option+Command+Shift (Mac) or Alt+Con-
trol+Shift (PC) as you start Illustrator. The new preferences files are created the next time 
you launch Illustrator. 

General
The General section contains the preferences that don’t fit neatly in the other categories. 
These are all global preferences.
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Keyboard Increment

This value represents how much an object will move when you use the arrow keys on the 
keyboard. 

Constrain Angle

This the degree to which an object will rotate when you hold down the Shift key while turning 
the object.

Corner Radius

This describes the default rounded corner size when drawing a rounded rectangle. 

Show Tool Tips

The Tool Tips become visible when you hover the cursor over a tool. This feature is useful for 
new users but these impact the performance of Illustrator.

Anti-aliased Artwork

Anti-aliasing is the smoothing of jagged edges when the artwork is being viewed in Pixel 
Preview.

Select Same Tint %

This allows the selection of a color that has a tint applied to it and other colors with that same 
tint percentage.

Show The Home Screen When No Documents Are Open

The Home Screen shows recent documents, new document presets, and Adobe stock 
templates.

Use Legacy “File New” Interface

The legacy File New interface is an older version of creating a New File. 

Use Preview Bounds

When aligning objects, the coordination is based on the object’s shape and not its boundary 
or edge. That is to say that when a stroke is applied to an object, the object will not align to 
the edge of the stroke, but instead to the shape of the object. Preview Bounds will have them 
align to the edge of the stroke or what you preview on screen.

Display Print Size at 100% Zoom

Shows the actual size of the printed piece when the zoom size is at 100%.

Append [Converted] Upon Opening Legacy Files

This setting will convert and update older files to the current version of Illustrator. A Dialog 
box appears informing you of how the file is being converted.
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Double Click To Isolate

This function is used isolate a layer, sublayer, path, or group of objects without having to 
ungroup the file or find the objects in the layers panel. If you find that you are a frequent 
“double-clicker” and you are in Isolation mode inadvertently, turn this option off.

Use Japanese Crop Marks

This creates crop marks for Japanese printing.

Transform Pattern Tiles

This transforms the pattern in an object when the object is scaled. This can also be set in the 
Transform panel.

Scale Corners

When scaling or transforming an object with rounded corners, this option scales the corners 
in proportion with the object. This can also be turned on and off in the Transform panel.

Scale Stroke & Effects

When scaling or transforming an object with a stroke and/or effect, this option scales the 
stroke/effect in proportion with the object. This can also be turned on and off in the Trans-
form panel.

Enable Content Aware Defaults

This feature works with the Puppet Warp tool to add pins where it identifies the best location 
for warping.

Reset All Warning Dialogs

From time to time, dialog boxes will pop up warnings informing you of important items. 
Those dialog boxes may have a checkbox that says “Don’t Show Again.” Once that box is 
checked and you click OK, the dialog will not appear again. Click the reset button to see the 
dialog boxes again.
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Selection & Anchor Display
This is where you adjust how lines and anchor points act and appear. 

Selection
This defines how items can be selected, and how they will look once selected.

Tolerance

This sets the pixel range for anchor points. A lower values means you  have to be closer to an 
anchor point to be able to select it.

Object Selection by Path Only

This limits selection of an object to clicking on just the path—not inside the shape. I would 
not use this option because it makes it more work selecting objects.

Snap to Point

This snaps objects to anchor points and guides. You can set the distance between the object 
and anchor point or guide; larger number means it will snap from farther away.

Command Click to Select Objects Behind

When objects are stacked on each other, use Command+Click (Mac) or Control-Click (PC) to 
select objects on the bottom of the stack without moving the objects on top out of the way.
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Constrain Path Dragging on Segment Reshape

This feature allows you to reshape a path in a relative transformation. This keeps the control 
handles in alignment on their original angles when transforming.

Show Anchor Points in Selection Tool and Shape Tools

When this is enabled, anchor points will show on an object when using the Selection or 
Shape tools.

Zoom to Selection

When this feature is enabled, the point of the zoom will be centered on a selected object. 

Move Locked and Hidden Artwork with Artboard

Moving artboards around will move all the visible and unlocked content. To have everything 
move with the artboard, check this box to enable this feature.

Anchor Points, Handle, and Bounding Box Display

Size

This sets the size of the handles and anchor points.

Handle Style

This sets the look of the handles but does not change their functionality.

Highlight Anchors on Mouse Over

With this function enabled, anchor points on an object will be indicated when you mouse 
over them.

Show Handles When Multiple Anchors Are Selected

By default, when an anchor is selected, it will only show the handles associated with that 
point. Click this box to have it show all the handles on the shape when a point is selected.

Hide Corner Widget for Angles Greater Than:

This hides the corner widget indicator when angles are set to a specified value.

Enable Rubber Band for: 

When you enable the Rubber Band for any lines made with either the Pen tool or the Curva-
ture tool, it will show both the curve of a path and how the points on the line connect.
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Type
This section controls text behavior and display.

Size/Leading:
This controls the increments in which the size/leading will change using the keyboard short-
cuts. The default setting for the size of type is 2 pt; I suggest 1 pt for finer adjustments. 
Press ⌘+Shift+</Ctrl+Shift+< to decrease the size or ⌘+Shift+>/Ctrl+Shift+> to increase 
the size (respectively). To adjust the leading, press ⎇+↑ / Alt-↑ to decrease leading or ⎇+↓ / 
Alt-↓ to increase the leading.

Tracking:
This controls the increments in which the kerning will change using the keyboard shortcuts. 
The default is 20/1000; I suggest 10 pt for finer kerning adjustments. To kern the space be-
tween two character, place the type cursor between the characters and use ⎇+← / Alt-← to 
tighten the letter spacing or ⎇+→ / Alt-→ to loosen the letter spacing. Tracking works the 
same as kerning; the only difference is tracking is spacing that is applied to multiple charac-
ters at one time. The shortcuts for tracking and kerning are the same. 

Baseline Shift:
This controls the increments in which the baseline will change using the keyboard shortcuts. 
The default is 2 pt; I suggest 1 pt for finer adjustments.
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Language Options
When creating Illustrator files in different languages, check the applicable language box.

Type Object Selection by Path Only
This limits the selection of text to clicking on just the path, not on the text areas. This is not 
recommended because it makes for more work selecting text.

Show Font Names in English
This displays font names in English if the fonts are not in English originally.

Auto Size New Area Type
This function automatically resizes the Area Type container to fit the amount of text entered. 
It’s a helpful feature because it saves a step in closing and opening up Area Type containers. 

Enable In-Menu Font Previews
This displays the name of the font and the selected text in that font.

Number of Recent Fonts
This displays the listed number of recently used fonts in the font menu.

Enable Japanese Font Preview in ‘Find More’
Click this box to display Japanese fonts when you click on the Find More (fonts) item in the 
font menu.

Enable Missing Glyph Protection
Choose this item to automatically select incorrect, unreadable characters between roman 
and non-roman fonts.

Highlight Substituted Fonts
When opening an Illustrator file, there may be fonts that are missing from your system and 
don’t display correctly. This feature highlights the incorrect font to make you aware that it is 
substituted.

Fill New Type Objects with Placeholder Text
When drawing a new area text container, this feature autofills the container with place-
holder text.

Show Character Alternates
Character Alternates are different styles of the same letter. With this option enabled, a small 
menu will appear below a letter with alternate options available in that typeface. 
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Units
Units are basic settings for how things are measured.

General:
These are the increments for measuring objects, position, spacing, and size. The available 
choices are points, inches, millimeters, centimeters, and pixels. 

Stroke:
Your choices for units to measure the weight of the stroke are points, inches, millimeters, 
centimeters, and pixels.

Type:
Here you can chose a unit to measure the size of the type. Points are the standard for mea-
suring type. 

Identify Objects By:
This feature identifies the object by its description. XML identifies each object by a unique tag.
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Guides & Grid
For alignment and control of artwork, guides and grids are helpful.

Guides

Color:

Set the color of the guides by clicking on the color square. 

Style:

Guides can be displayed as colored lines or dots. 

Grid

Color:

Set the color of the guides by clicking on the color square. 

Style:

Guides can be displayed as colored lines or dots. 

Gridline Every:

This draws major grid lines based on this value. 
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Subdivisions:
This divides the major grid lines into subdivisions based on the value.

Grids in Back:

This creates the grid to appear behind the artwork.

Show Pixel Grid

When working in Pixel Preview mode, this option will show the grid only when the file is 
zoomed into 600% or greater.

Smart Guides
These options provide you with more ways to give structure to your layout. Here you set the 
appearance and action of Smart Guides.

Display Options
Here you can choose how close the Smart Guides appear and function.

Color:
Here you can choose the color of the Smart Guides from a full spectrum of color.
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Alignment Guides
This feature shows alignment to edges and centers of other objects and the artboard when 
Smart Guides are active.

Anchor/Paths Labels
This features shows tool hints identifying an anchor, point, path, or center on an object when 
these items intersect or align.

Object Highlighting
With this function enabled, objects will be highlighted as you drag them around the work-
space. The highlight color matches the object’s layer color.

Measurement Labels
This function displays size information for many drawing tools and text tools.  Labels show 
the position of the object on the artboard using X and Y coordinates. While you create, select, 
move, or transform objects, these labels appear. 

Transform Tools
This displays size and angle values when you scale, rotate, and shear objects.

Spacing Guides
These display guides show the spacing between two objects when a third object is being 
placed to match the spacing of the first two objects.

Construction Guides:
These guidelines appear as you draw new objects. The values represent the angles at which 
the guidelines will be drawn from the anchor points of a nearby object. 

Snapping Tolerance:
This value specifies the number of points the object must be from another object for Smart 
Guides to take effect.
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Slices
This section is for slicing a file for web use.

Show Slice Numbers
This labels each slice with a number for easier identification.

Line Color:
Here you can choose the color of the divider lines that indicate the slices.

Hyphenation
This section allows you to set the language for the hyphenation regulations. These correc-
tions, (or exceptions) are typically stored in the User Dictionary.
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Plug-ins & Scratch Disks

Additional Plug-ins Folder

Plug-ins add more features and capabilities and are generated by third parties outside of 
Adobe. Check the box to choose the appropriate folder to locate the plug-ins. 

Scratch Disks
Scratch space on the hard disk drive is dedicated to temporary storage while working in Illus-
trator. A disk that is near full or full can slow down the performance of the program.

Primary

This indicates the main hard drive in your device.

Secondary

This indicates a backup device to allow for more room as needed if the primary become full.
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User Interface
These options allow you to configure how light or dark the interface appears, how the panels 
function, and the overall size of the interface.

Brightness:
This allows you to choose either a dark interface with light callouts or a light interface with 
dark callouts.

Canvas Color:
This allows you to set the canvas area outside the artboard to your chosen interface color. 
Select white if you don’t want the canvas to match the interface. 

Auto-Collapse Iconic Panels
When using the panels, this option allows you to expand and auto-collapse a panel when 
done. If you  need the space on your screen, this helps. If you don’t need space, this adds the 
extra step of opening the panel each time you need to use it.

Open Documents as Tabs
This opens all documents in one window with each document identified as a tab instead of 
an individual floating window.

Large Tabs
This creates larger tabs that identify each open document window.
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UI Scaling
This scales the user interface up so it’s larger and easier to see. As indicated, it changes the 
size of tools, text, and other UI elements proportionally. The scale adapts to your current 
screen resolution. 

Scale Cursor Proportionately

This scales the cursor size when the user interface is scaled. 
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Performance
Not your performance—the performance of Illustrator!

GPU Performance
The Graphics Processing Unit (GPU) is part of the video card/display and is designed to rap-
idly execute commands for manipulating and displaying images. There are known issues that 
may be encountered when GPU Performance is enabled. They are: Rendered artwork appears 
jagged, black, or white; or Illustrator crashes. Documents appear in black-and-white. You 
may receive an error message that GPU Performance Features are not available in the docu-
ment you are currently working on, or the width lines may look tapered, or the ends vanish.

Turn off GPU Performance to see if these problems are part of the GPU.

Animated Zoom

This makes zooming actions smooth and animated.

GPU Details
This displays an overview of your system.

Others

Undo Counts:

This value controls the number of undos available. The default is 100. More undos may slow 
performance.
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File Handling & Clipboard
The options in this section control file saving and the copying of data.

Data Recovery

Automatically Save Recovery Data Every:

Yes, you do want to automatically recover data in case Illustrator crashes (and it will crash). 
This options sets up an “auto save” every two minutes as a default. This is not a substitute for 
frequent saving of the file but it is a worthwhile safety net.

Turn off Data Recovery for Complex Documents

When data recovery is turned on, Illustrator may pause while backing up large or complex  
files. If this slows down or interrupts your workflow, select the checkbox to turn off data  
recovery.
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Files

Number of Recent Files to Display (0-30):

This sets the number of recent files that will appear in the File menu or the Startup window. 

Use Low Resolution Proxy for Linked EPS

In this mode, linked EPS files will display as low resolution to save memory and increase 
program performance.

Display Bitmaps as Anti-Aliased Images in Pixel Preview

This smooths the appearance of a Bitmap image when in Pixel Preview mode.

Updates Links

This determines how links will be updated. The options are Automatically, Manually, or Ask 
When Modified.

Clipboard

On Copy:

When copying content, check this option to include SVG data. 

On Quit:

If you have copied content and quit Illustrator, a dialog box will appear and ask what you 
want to do with the clipboard contents. Content can be saved as a PDF, as paths, or as paths 
that preserve the Appearance and Overprints as they were created in Illustrator.
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Appearance of Black
Just when you thought black was black! These options allow you to set the appearance of 
black elements in your workspace.

On Screen:

I choose to display all blacks accurately on-screen. This means that items that use the pure 
black (100% K) swatch will look slightly lighter or more gray than a rich black, which is made 
from black ink plus other inks to make it appear more saturated.

Printing/Exporting:

This is the confusing one. Choose Output All Blacks as Rich Black, then hover your cursor 
over that choice and note the description below that attempts—but fails—to clarify what 
that means. What it means is that on a device that has only black ink or toner, both rich 
blacks and pure blacks will print as dark as possible. RGB devices refers to common desk-
top inkjet printers. However, with this choice, color laser printers and printing presses (true 
CMYK devices) will still produce blacks accurately: pure black will use black ink or toner only, 
and rich black will be output as designed. Since I output to all of these devices, I choose the 
confusing Output All Blacks as Rich Black setting. It works!
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Workspaces

Panel Locations
Illustrator has lots of panels that can crowd your work area. Each panel can be moved, min-
imized, attached to other panels, or made free-floating. You can create a combination of 
panels and designate them as a workspace. Setting up workspaces based on your workflow 
can be very helpful. I use certain panels for creating logos and other panels when creating 
infographics, and I set a workspace based on the panels I use for that task.

Choose A More Useful Initial Workspace
When you open or create a document, select Window > Work-
spaces and choose from a preset list of workspaces depend-
ing on the type of creation you intend to work on. 

In each of these preset workspaces, Illustrator has in-
cluded a set of panels it recommends for that type of work. 
Once you choose a workspace, the panels will appear on your 
screen. This can be a great way to get started; as you progress 
you may want to change the arrangement or location of the 
panels to best suit your needs. 

Creating a New Column of Panels
To create a new dock of panels alongside the first, drag a 
panel by its name toward the original dock until a dense blue 
vertical “drop zone” appears. Collapse the new column with 
the small double arrow (>>) in its upper-right corner. Drag in more panels under the first. 
I suggest adding the Properties panel to this second dock to easily access (and collapse) it.

Adjust the width of this new dock by dragging its left edge. You can shrink it until the 
names are gone and only icons remain if you like.

Individual panels have drop zones, too. If you drag one panel to the bottom edge of a 
free-floating panel, you will create a free-floating dock. Or, if you drag a panel’s name next to 
another panel’s name, the drop zone is the small window itself; that is, both panels’ tabs will 
be side by side in the same window.

Once your panels are located where you want them, return to the workspace menu and 
choose New Workspace…. We can name this “Real Essentials.” Later, if this workspace be-
comes untidy, we can once again use the workspace menu and choose Reset Real Essentials.
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Customizing Menus and Keyboard Shortcuts

Keyboard shortcuts are fantastic. When you are starting to learn a new application there may 
be a bit of time hunting and pecking through the menus trying to find commands, but these 
tips will help for both menus and tools shortcuts.

What’s on the Menu?
Go to Edit > Keyboard Shortcuts to be presented with a large dialog box with lots of options. 
There is a dropdown list for setting shortcuts for the tools and for menu commands.

 
The Keyboard Shortcuts dialog box will list all the tools and any shortcuts associated with 
those tools. Not all tool will have shortcuts, but the most-used tools will. If your workflow 
requires the use of tools that do not have shortcuts applied as a default, click on the tool 
and the Shortcut and Symbol field will become active. Enter in a shortcut that best fits your 
workflow. If you enter a shortcut that is already in use (that is, it’s applied to another tool), 
there will be a conflict. You can override that conflict and use your shortcut as the default or 
choose different shortcut command, keeping the original shortcut intact.
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Undo will return the original shortcut to the default. Go To Conflict will go to the tool that has 
that keyboard shortcut you want to use. Clear will clear the default shortcut on that tools and 
allow you to enter that shortcut for another tool. 

Once a new default shortcut is created, the Tool Hint will reflect that new shortcut when 
you hover your cursor over the tool. 

This process is the same when you choose Menu Items from the list. Any new shortcuts 
will be reflected next to the Menu command. 

Any changes to the default shortcuts will require you save the shortcuts as a new set. The 
Illustrator defaults cannot be overwritten so any changes will require a newly named set of 
shortcuts when you click OK. A dialog box will appear asking for a new name for your custom 
presets. Enter in a name and click OK. 

Keys to Success
You have seen those posters online that can show you all the shortcuts—and you can pur-
chase it for $25.00. Instead, you can make your own for free! Click on the Export Text… button 
and you will get a text file that reflects all the default and customized shortcuts.
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Creating a New Document

Let’s gets started. You will need to create a new document so you can begin creating. Choose 
File>New… to begin. The New Document window displays preset sizes, any recent files, Adobe 
Stock Templates, presets for the type of file you will be creating, as well as sizes and artboard 
orientation.

Presets
At the top of the New Document window there are presets for Mobile, Web, Print, Film & 
Video, and Art & Illustration. The presets will give you a list of common document sizes to 
choose from to begin creating. Or you can create a custom-size document from the settings 
on the right side of the dialog box.
Mobile, Web, and Film & Video: This preset displays common phone and tablet sizes (Mo-
bile), commonly used web sizes, or common film and video formats. Below the presets you 
have access to Adobe Stock Templates, some of which are free. These presets use pixels as the 
unit of measure, the document is in RGB mode, and the resolution is set to 72 ppi.
Print: This preset displays paper sizes and Adobe Stock Templates for print work. Print pre-
sets use points as the default unit of measure, which can be changed via the Unit dropdown 
menu and the document is in CMYK mode. The resolution is set to 300 ppi.
Art & Illustration: This preset displays paper sizes and Adobe Stock Templates for creating 
artwork or Illustrations work. Art & Illustrations presets use points as the default unit of 
measure (which can be changed) and the document is in RGB mode. The resolution is set 
to 72 ppi.
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Document Sizes 
Creating a new custom document can be done easily if the presets are not what you are look-
ing for. On the right side of the New Document window you can set the parameters for your 
document. 

Set the width and height of the document. The unit of 
measure can be changed from the dropdown menu. Choices 
include  Points, Picas, Millimeters, Centimeters, Inches, 
and Pixels.

Set the orientation of the document to be portrait or 
landscape. 

Set the number of pages… umm, artboards. Illustrator 
does not use pages since it is not a page layout application—
that is what Adobe InDesign is for. Illustrator uses artboards 
yet you may hear them refereed to as pages as a generic 
descriptor.

Bleed can be set on all sides of the document. This does 
not change the size of the document, it creates guides outside 
the artboard for extending artwork for bleed purposes. 

Advanced Options
To set more options for the new document, click on the  Ad-
vanced Options arrow. 
Color Mode: Choose RGB for work that will be displayed on 
phones, tablets, computers, or TV screens. Choose CMYK if 
the creations will be printed.
Raster Effects: This setting allows the rendering of any ras-
ter effects to be high resolution (300 ppi), medium resolution 
(150 ppi), or low resolution (72 ppi). This may not seem rele-
vant since Illustrator is a vector-based application but there 
are some effects that can be applied that render as raster 
(pixel-based) output.
Preview Mode: Choose from Default preview, Pixel preview, or Overprint preview. I leave it 
as Default and change it in the document when I need to preview artwork in the other modes.
More Settings: Click to find a few extra settings for setting up artboards.  
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Artboards

Illustrator has artboards instead of pages. Since Illustrator is more about creation and than 
it is about formatting books, we use artboards instead of page layouts. When creating a 
new document, you can specify how many artboards you would like, or you can easily add 
them later.

Artboard Panel
The Artboard panel is located under Window>Artboards. This displays the artboards in order 
and by name, and offers options to edit, add, or delete artboards.

Rearrange  
artboards

Double-click  
to rename Double-click  

for artboard 
options

Delete  
artboard

Reorder 
artboards 

(move up or  
down the list)  

New 
artboard 

Naming the artboard can be done by double-clicking on the name to open the edit field. Type 
in the new name and click Return. Options can be accessed by double-clicking on the art-
board icon. Use the dropdown menu to access other options such as add, delete, or duplicate 
artboards.



127Artboards  |  ﻿Artboard Options
Sh

ap
e

 
C

re
atio

n
A

d
van

c
e

d
 

C
o

n
stru

c
tio

n
E

d
itin

g
 &

 
Tran

sfo
rm

atio
n

Typ
e

 &
 Te

xt 
E

ff
e

c
ts &

 
G

rap
h

ic
 Style

s
W

o
rkin

g
 w

ith
 

C
o

lo
r

P
referen

ces &
 

W
o

rksp
aces

O
u

tp
u

t 

Artboard Tool
The Artboard tool (Shift + O) is an easy way to edit, add, or modify artboards.   When 
you click on the Artboard tool, the artboard(s) in your document will be directly ed-
itable. The background around the artboards will darken and one of the artboards 
will have a blue dashed line around it idicating it is ready for editing. 

Click on any artboard with the Artboard tool to begin editing. You can pull the 
corner pull handles to change the artboard size and position. To exit out of editing 
mode, select any tool from the toolbar. 

Artboard Options
To get more Artboard Options, double-click on the Artboard tool to open the options panel.

Name the artboard

Orientation

Size presets

Constrain 
proportions 

when resizing

Reference point 
location

Display and 
guide options

This is a  
great option
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Layout Artboards
To layout and arrange the artboards, dou-
ble-click on the zigzag icon at the bottom left of  
the Artboard panel. You can also choose Rear-
range All  Artboards… from the Artboard panel 
drop- down menu.

The default layout is left to right. Change the 
layout order by clicking the icon from up to down 
or in a line vertically or horizontally. Layout order 
can read left to right or right to left.

If the column layout is chosen and there are 
enough artboards, you can set the number of columns. Spacing between the columns is set 
here as well.

Move Artwork with Artboard is a good option that will keep track of artwork if the art-
boards move. 

Convert to Artboards
If using the Artboard tool to create artboards is not working, or the add artboard command 
is to hard to get to, you can draw a rectangle or square using the Rectangle tool. Select the 
rectangle and choose Convert to Artboard from the Artboard panel dropdown menu. This 
does not work with any other shape tool but the Rectangle tool. 

Duplicate Artboards
I love this feature. When I am working on a logo for a client and they want several different 
versions, I will make one logo per artboard. Then, for different versions I will duplicate the 
artboard and begin a new version. Why create multiple artboards instead of just one art-
board with several logos? Good question! It is easier to reference the designs if they are on 
separate artboards and when I save them as a PDF, each artboard will be a page in the PDF 
document. I can also print any artboard or artboards I want instead of one artboard with all 
the logos on it.

My favorite method of duplicating an artboard is to select the Artboard tool and Option 
+ click (Mac) and drag the artboard to duplicate it (use Alt + click and drag on a PC). You 
can select the artboard and choose Duplicate artboard from the Artboard panel dropdown 
menu as well.

Printing Artboards
When it comes time to print, the artboards can be printed as separate pages. Any artwork 
that is not on an artboard will not print so make sure all your work is done on an artboard 
and nothing is off the edge. We will discuss this is greater detail in the section on printing.
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Layers Panel

Click to turn 
on/off layer 

visibility

Click to lock/
unlock layer

Layer

Sublayers

Double- 
click to edit 
layer name

Bounding 
box color 

Collect for 
Asset Export

Target (select) 
the object in 
the layout

Active and 
selected 
object

Delete layer

Locate 
Object

New  
layer

Make/release 
Clipping Mask

New  
sublayer
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About Layers
When creating artwork in Illustrator things can get complicated. It can be challenging to 
keep track of, select, group, edit, move, and find all the items of your artwork. Objects can be 
inside groups or in a clipping mask, behind other items, or locked, and selecting that object 
becomes difficult or frustrating. Layers provide a way to manage all the items that you have 
created in your artwork. One way of understanding Layers it to think of them as clear folders 
that contain artwork. You can put items into the folder (those are sublayers) and easily move 
the layers above or below to bring them in front of or behind other layers. These layers can be 
grouped to move or transform as one unit and can be locked or hidden so they are protected.

The Layers panel (Window > Layers) will help organize, list, and edit the objects in a docu-
ment. The blue bounding box around each shape is the color indicator of the layer. The same 
color shows the bounding boxes, paths, anchor points, and then center point of the object. 
This color is a reference to quickly locate what layer the object is on in the Layers panel.  You 
can change the layer color to suit your needs.

Every new Illustrator document contains one layer, and each object you create is listed 
under that layer as a sublayer. You don’t need the layers panel for simple artwork, but it will 
make navigating, editing, working with, and creating so much easier and efficient that once 
you get the swing of it, it will become a must-have in all your Illustrator creating.

Layer Panel Overview
The Layers panel has one layer by default. Under this layer is where all the content you create 
in the artwork will be—these are sublayers.

When a layer in the Layers panel contains other sublayers, a triangle shows in the upper 
left of the layer’s name. To see all the sublayers click on the arrow to the left of the layer 
thumbnail to open it.

Visibility Column

An eye icon shows the visibility of the layer or sublayer. Click the eye to turn on or off the 
visibility. Keep in mind that when you print a file, that layer will not print unless you either 
turn the visibility back on or you choose Print All Layers from the Print layers section of the 
Print dialog box. 

Edit Column

Second in from the eye icon shows whether the layer or sublayer is locked or unlocked. Click 
the area  to show the lock and that layer will not be moveable or editable. Click the lock to 
unlock the layer for editing.
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Target Column

Target seems like the wrong word to use here if you think of a target as something that is be-
ing selected. Illustrator uses the word target to indicate whether the item has an effect or at-
tribute applied from the Appearance panel. When the target button appears as a double ring 
icon, the item is targeted (it has an effect or attribute applied); a single ring icon indicates that 
the item is not targeted. The effect or attribute could be a drop shadow or transform effect 
or an opacity on the object, and the target informs you that this object has something extra.

Selection Column

This column indicates whether or not items are selected via a small box (the same color as 
the one on the far right of the layer, next to the target icon). When an item is selected within 
a group, a smaller color box appears next to the parent item (the group that it is in) as well 
as the top-level layer of sublayers. If all of the objects within the parent item are selected, the 
selection color boxes are the same size as the marks that appear next to selected objects. You 
can dim any linked images and bitmap objects to make it easier to edit or trace over artwork 
on top of the image.

Layer Management Best Practices
There is no ideal way of managing layers, layer order, and naming in Illustrator; yet there 
are some very helpful tips to make your life, and your Illustrator files, easier to manage and 
navigate. 

Let’s look at the artwork as though you are building a house. Start building the house (your 
new document) by choosing the size and color modes. 

The build process may begin with an image placed in a file on a layer so you can trace over 
it; or the sketch may be in your mind ready to go. Build your foundation, then build the house 
on the foundation. Think about what goes into all the behind-the-scenes content. Naming the 
layer Background or Base may be a good start. 

Once the base is done, create new layers for the more detailed levels of the “house”: first 
floor, second floor, roof layer. Now you can go back and turn on and off the visibility of the 
layers and begin to add details. You may have a layer right above the first floor that is all the 
rooms. You may want to break out each room on that floor as a layer—name the rooms some-
thing that makes sense and is easy to understand. 

How far do you go with layers? Each room as a layer may be just right. Is there furniture 
in each room? Is there a layer for each piece? Possibly: it can be very easy to select the “chair” 
and edit it as one layer. I would not, however, break down the chair into further folders be-
yond that one item. 
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Naming 
An important aspect of working with layers is naming everything 
in a way that helps you stay organized. The default layer-naming 
convention is Layer 1, Layer, 2, Layer 3…, yet when you create art-
work, Illustrator assigns names to each sublayer (indented below 
the layer) based on what the shape, type, or image is. For instance, 
if you draw a rectangle, that sublayer will be labeled  sublayer 
<Rectangle>. You can edit this title by typing in a line of text that 
describes the contents of the layer. This is very helpful for identifying each object that makes 
up your artwork. 

When I create artwork I begin with the base artwork (the content in the background). 
What goes on the artboard first? It may be a shape filled with color, a pattern, or an image. 
Since layers build on top of each other, any layer that is added to the Layers panel is added on 
top of the previous layer by default. Layer order can be changed, but I like to think of a pro-
cess of building this list like I think about the house. Start with the foundation and frame and 
build the house one floor at a time. Put the roof on it, then start adding the colors and details. 

Be consistent when naming layers: be careful of uppercase and lowercase letters, and be 
brief and descriptive for optimum efficiency. The Layers panel doesn’t take up much screen 
space, so using long layer names may require you to open the panel up wider—taking up 
more working space. Be especially careful about naming the top layer, because that’s the title 
heading by which you’ll search for filed objects.

Think of layer order 
and naming like 
building a house. 

Start with the foundation, 
build each floor, add 
the roof, and then 
add the details.  

In this example, I use 
a recipe for beef stew. 
In this infographic I 
break down the main 
components into folders, 
then each complete 
step (or ingredient) gets 
a folder within it. 

5
4
3
2
1

1

2

4

5

3
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For Segregating Content
With the example of the beef stew recipe, the main components of the recipe are the Back-
ground, Framework, Ingredients, Steps, and Hero image. Segregating the content into these 
top-level folders makes it much easier to find and isolate each component within the artwork. 

For Protecting Content
When your file has many components, trying to select, edit or move, modify or remove a 
shape, path or fill can be harder than you think. Some may be grouped together, behind an-
other object, or inside a Clipping mask. If I wanted to select the background shape, I may 
end up selecting the content above and not be able to get to the background shape without 
moving my upper level content. 

Layers allow you to segregate the content into its main components, which can be locked 
or have their visibility turned off so that other content can be accessed without modifying or 
moving anything to get to the underlying content. This makes the workflow very efficient and 
much less frustrating.

Creating New Layers
In the Layers panel, click the name of the layer above 
which (or in which) you want to add the new layer. Layers 
are added on top of the layer you have selected 

To add a new layer above the selected layer, click the 
Create New Layer button in lower-right side of the Layers 
panel. To create a new sublayer inside the selected layer, 
click the Create New Sublayer button  in the Layers panel.

New LayerNew Sublayer
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Layer Options
To set layer and sublayer options, double-click 
the item name in the Layers panel or select the 
layer name and choose Options For <item name> 
from the Layers panel dropdown menu.
Name: Add a name for the layer or sublayer.
Color: Select a color that identifies that layer. The 
layer color shows on the selected items’ bound-
ing box to indicate the layer the object is on.
Template: This makes the layer a template layer.
Lock: This prevents changes to the item.
Show: This turns on or off the visibility of all art-
work contained in the layer on the artboard.
Print: This makes the artwork contained in the 
layer printable or not printable.
Preview: This displays the artwork contained in the layer in color instead of an outline.
Dim Images: This reduces the intensity of linked and bitmap images contained in the layer 
to a specified percentage.

Panel Options

Row Size
In these options you can set the size of the layer thumbnails. 
By default they are small, so you have your choice of a preset 
size or to enter in a pixel preview size in the Other field. 

Thumbnails
You can set the visibility of thumbnails for all the layers and 
sublayers (they are all on by default). Unchecking the boxes 
will show the layer with no corresponding thumbnail.
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Layer Order

Moving Objects to Layers
You can move an object from one layer to another in a few different ways. Make sure the layer 
with the object and the destination layer are both unlocked. 

Select the object you want to move with the Selection tool. Click the name of the destina-
tion layer in the Layers panel, then choose Object > Arrange > Send To Current Layer from the 
Layers panel dropdown menu.

Drag the selected-art indicator (small color 
square), located at the right of the layer in the 
Layers panel, to the layer you want.

Create a New Layer While Moving
You can move objects or layers into a new layer by 
selecting the items and choosing Collect in New 
Layer from the Layers panel dropdown menu. 
Hold down Command (Mac) or Control (PC) to 
select nonconsecutive items; hold down Shift to 
select consecutive items.

Reordering Layers
This is helpful for moving items into and out of groups, as well as reordering layers and their 
content. To move or reorder layers or sublayers, click on the name of the layer or sublayer and 
drag it up or down the Layer panel to reorder the content. 

Bring to Front/Send to Back
You can use the Object>Arrange> (Bring Forward, Bring to Front, Send Backward, Send to 
Back) to reorder the layers as well. 
• Bring Forward: Moves the object forward one layer at a time. 
• Bring to Front: Moves the object forward to the top of the group or to the top of the layer. 
• Bring Backward: Moves the object backward one layer at a time. 
• �Bring to Back: Moves the object backward to the bottom of the group or to the bottom of 

the layer.
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Selecting Objects
When your files get complicated, trying to select or locate them can be a monumental task if 
you’re trying to click on it with the selection tool. In the Layers panel you can select the object 
by clicking on the layer, then clicking to the right of the target icon. A color box will appear 
showing that the object is selected. That object will now be selected in the artwork. 

Locating Objects
You may be working on your artwork and have an item selected, and now you want to find 
where it is in the Layers panel. Use the Locate Object command from the Layers panel drop-
down menu. This command is especially helpful for locating items in collapsed layers.

Editing Groups
To edit a group of items, you do not need to ungroup the objects, make an edit, and then try 
to select all the parts and regroup them. Keep everything grouped and locate the group in the 
Layers panel.

Open the group by using the arrow to the left of the group name. Inside the group, select 
the layer you want to edit, then click on the circle (target) at the right of the layer. A color 
square will show next to the target, and the object will be selected on the artboard. This 
isolates the object so you can make edits to the selected object artwork without having to 
ungroup it.

Add Objects to a Group 
To add objects to a group without ungrouping the content, select the layer that is outside the 
group and drag the layer into the group in the stacking order you want.

Remove Objects From a Group 
To remove objects from a group without selecting the layer that is in the group, drag the layer 
outside of the group or into another group.
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Editing Clipping Masks
There are several ways to work on Clipping masks, but the Layers panel makes it easy because 
it works in the same way as editing groups. The one difference is the mask itself acts as a “win-
dow” where the artwork appears. 

Drag artwork 
into a clipping 
group

Drag artwork 
out of a  
clipping group

Adding to an existing mask requires releasing the mask, adding or editing the content, and 
remasking. In the Layers panel, you keep the mask and clipping intact and add, edit, or delete 
content like you would a layer group.

Consolidate Layers and Groups
Merging and flattening layers are similar in that they both let you consolidate objects, groups, 
and sublayers into a single layer or group. Merging layers allows you to select which items you 
want to consolidate into one layer. Flattening takes all the visible items in the artwork and 
consolidates them into a single layer. Both merging and flattening retains the stacking order 
of the artwork, but other layer-level attributes, such as clipping masks, aren’t preserved.

Merge Selected
To merge items into a single layer or group, hold Command (Mac) or Ctrl (PC) and click the 
names of the layers or groups that you want to merge. This allows nonconsecutive selection 
of the layers. To select a set of layers that are consecutive, click on the first layer then hold 
Shift and click on the last layer. This selects everything between the two layers or groups you 
clicked on. Then, select Merge Selected from the Layers panel dropdown menu. All items will 
be merged into the layer or group you selected last.

Layers can only merge with other layers that are on the same hierarchical level in the Lay-
ers panel. Likewise, sublayers can only merge with other sublayers that are within the same 
layer and at the same hierarchical level. Objects can’t be merged with other objects.

To flatten layers, click the name of the layer into which you want to consolidate the art-
work. Then select Flatten Artwork from the Layers panel dropdown menu.
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Release Items to Separate Layers
Release To Layers is used to prep files for web animation in which each object needs to be on 
a layer. The Release To Layers command redistributes all of the items in a layer and creates 
individual layers for each object. 
• �Release each item to a new layer: Choose Release To Layers (Sequence) from the Layers 

panel menu after you click on the layer.
• �Release To Layers (Build): To release items into layers and duplicate objects to create a 

cumulative sequence, choose Release To Layers (Build) from the Layers panel dropdown 
menu. The bottommost object appears in each of the new layers, and the topmost object 
only appears in the topmost layer. This is how cumulative animation sequences are created 
using this feature.
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